User Manual
Logistics Management
Logistics Service
Messaging Service
# Table of Contents

Before you begin ...

- Preface ........................................................................................................ 8
- What Is FleetBoard Logistics Management? ........................................... 8
- What Is the Logistics Service? ................................................................. 8
- What Is the Messaging Service? ................................................................. 9
- Other FleetBoard Modules ........................................................................ 10
- Document Conventions ............................................................................. 10
- Important Text Segments ........................................................................... 10
- Accessing FleetBoard Logistics Management ........................................ 11
- System Requirements .................................................................................. 11
- Initial Installation and Login ...................................................................... 12
- Contacting FleetBoard Support ................................................................ 12

1 General Operating Instructions

1.1 Starting FleetBoard Logistics Management ............................................ 14
1.2 Interface Structure .................................................................................. 15
  1.2.1 Menu Bar .......................................................................................... 16
  1.2.2 Components ...................................................................................... 17
  1.2.3 Buttons .............................................................................................. 18
1.3 Basic Functions of the FleetBoard Logistics Management Client ........... 19
  1.3.1 Context Menu ................................................................................... 19
  1.3.2 Drag & Drop ..................................................................................... 20
  1.3.3 Moving Columns ............................................................................. 20
  1.3.4 Show and Hide Columns .................................................................. 20
  1.3.5 Change the Column Width ............................................................... 21
  1.3.6 Sorting Data Sets in Tables ............................................................... 21
  1.3.7 Export .............................................................................................. 22
  1.3.8 Display Data in Mapping ................................................................. 22
1.3.9 Request a Vehicle Position .................................................. 23
1.3.10 Send Messages to a Vehicle ................................................ 23
1.3.11 Querying Information on FleetBoard ................................... 24

2 Planning Orders and Tours
   2.1 General Information on How to Plan Orders and Tours .......... 26
   2.2 How to Create and Administrate Orders and Tours ............... 27
      2.2.1 Create a New Order ...................................................... 28
      2.2.2 Create a New Tour ...................................................... 30
      2.2.3 Edit a Dispatch Data Set Subsequently ......................... 31
      2.2.4 Copy a Dispatch Data Set .......................................... 32
      2.2.5 Delete a Dispatch Data Set .......................................... 32
   2.3 Assign Orders to Tours ....................................................... 33
      2.3.1 Assign an Order to a Tour ......................................... 33
      2.3.2 Change the Sequence of the Orders of a Tour ............... 35
      2.3.3 Resetting the Assignment of an Order ....................... 36
   2.4 Assign Orders and Tours to Vehicles ..................................... 36
      2.4.1 Assign a Tour to a Vehicle ....................................... 36
      2.4.2 Reset the Assignment of a Tour .................................. 39
      2.4.3 Send a Tour .............................................................. 40
      2.4.4 Scheduling Tours ....................................................... 41
      2.4.5 Change the Send Time of a Scheduled Tour .................. 41
      2.4.6 Unschedule—Reset the Schedule of a Tour ............... 42
      2.4.7 Monitoring an Order ................................................. 42
      2.4.7.1 Arrival Monitoring ................................................ 42
      2.4.7.2 Area Monitoring ................................................... 42
      2.4.7.3 How to Configure Arrival or Area Monitoring .......... 43

3 Working with Templates
   3.1 General Information on Templates ....................................... 50
   3.2 Create a New Template ...................................................... 50
3.3 Create a Template from an Existing Order ........................................ 51
3.4 Create a New Order with the Help of a Template .......................... 51
3.5 Delete Templates ............................................................................ 52

4 Messaging
4.1 General Information on the Messaging Service ............................ 54
4.2 Info Board ..................................................................................... 55
4.3 Send Message to Vehicle ............................................................... 56
4.4 Send Address to Vehicle ................................................................. 58
4.5 Display Messages .......................................................................... 61
   4.5.1 How to Read the Messages List ............................................ 62
   4.5.2 Various Message Types ....................................................... 63
4.6 Open the Detail View of a Message ................................................ 65
4.7 Latest Infos and Search .................................................................. 66

5 Tracing Sent Tours and Orders
5.1 General Information on How to Monitor Orders and Tours .......... 68
5.2 Info Board ..................................................................................... 69
   5.2.1 Display Messages .................................................................. 70
      5.2.1.1 How to Read the Messages List .................................... 71
      5.2.1.2 Various Message Types ............................................. 72
   5.2.2 Open the Detail View of a Message ....................................... 74
   5.2.3 Modify Data of Already Existing Orders ................................. 74
   5.2.4 Rearrange Tours or Orders Sent ........................................... 74
   5.2.5 Complete Orders and Tours Manually ................................ 75
5.3 Latest Infos .................................................................................... 77

6 Search for Messages
6.1 Structure of the Search Component .............................................. 80
6.2 Search for Messages with Known ID ........................................... 81
6.3 Search for Other Search Parameters ............................................ 82
6.4 Evaluate the Search Results ......................................................... 83
7 Appendix

7.1 Important Symbols ......................................................................................... 86
7.2 Modify Settings for the Log File ..................................................................... 88

Index
Chapter
Before you begin ...

Preface ....................................................................................................................8
  What Is FleetBoard Logistics Management? ..........................................................8
  What Is the Logistics Service? .................................................................8
  What Is the Messaging Service? .................................................................9
Other FleetBoard Modules ...........................................................................10
Important Text Segments ...........................................................................10
Document Conventions ..............................................................................10

Accessing FleetBoard Logistics Management ..................................................11
  System Requirements ..................................................................................11
  Initial Installation and Login ......................................................................12

Contacting FleetBoard Support .......................................................................12
Preface

FleetBoard from Mercedes-Benz is an Internet service making use of the latest in telematics system technology. It provides effective and efficient fleet management, focusing on both technical issues and logistics. FleetBoard is a protected trade-mark proprietary to the commercial vehicle division of Daimler.

The FleetBoard hardware consists of the on-board computer and the DispoPilot.

The FleetBoard hardware collects the data in the vehicle and transmits it to the central FleetBoard server. All relevant vehicle, tour, and order data can be queried at the push of a button.

What Is FleetBoard Logistics Management?

For the purpose of Logistics Management, FleetBoard offers the Logistics and Messaging services. The FleetBoard Logistics Management Client provides access to these two services. When purchasing FleetBoard Logistics Management, you decided to acquire one of the two services.

What Is the Logistics Service?

Logistics is a service which supports the logistics processes as well as the transport procedure. In combination with the hardware in the vehicle, it permits the direct communication between the vehicle and the central server and, thus, allows the efficient planning of tours and order management. FleetBoard Logistics offers you a range of options, including:

- Importing the orders from existing haulier software or manual input,
- Allocation of orders to tours and assignment of these tours to vehicles,
- Transmission of this data to the vehicle,
Support of the dispatch office in the monitoring of transport processes via functions such as order status and tour status query, as well as identifying current vehicle positions.

What Is the Messaging Service?

The Messaging service offers you telematics-supported communication, which serves to introduce you to Logistics Management. In combination with the hardware in the vehicle (on-board computer and DispoPilot), it permits the direct communication between the vehicle and the central dispatch office. The DispoPilot offers you a navigation with truck attributes for 25 countries across Europe.

Within the Logistics Management Client, you have the following options:

- Transfer of text messages to vehicles
- Receiving text messages from the drivers
- Transfer of addresses, including the geographical coordinates to the driver for direct import into Navigation
- Receiving of navigation events when using the routing function for a transferred address.

NOTE

If you wish to use the Messaging service, please read Section General Operating Instructions, Page 13 first.

You can find information on the main functions of the Messaging service in Section Messaging, Page 53. Section Search for Messages, Page 79 informs you how to search for messages.

In Section Latest Infos, Page 77, you can find information how to display messages which were sent or received within the past 24 hours.
Other FleetBoard Modules

Vehicle Management, Mapping, Customer Administration, and Time Management are further FleetBoard modules. Vehicle Management permits the monitoring of data retrieved on wear and tear and consumable parts with the purpose of efficient fleet control. All relevant vehicle data sets are continuously available at the click of a button. In addition, Mapping allows you to view the position of vehicles on a map. Access rights of each individual employee are created and managed within the Customer Administration module. Time Management provides a comprehensive overview of driver working hours.

Document Conventions

The following document conventions are used:

- References to other manuals, chapters, and sections are displayed on the screen in blue font.
  
  Example:
  Refer to Section Contacting FleetBoard Support, Page 12.

- Navigation paths, buttons, text fields within the Internet interface, system messages, etc. are presented in italics.
  
  Example:
  Click the Help button.

- Individual parts of a navigation path are separated from each other with ">".
  
  Example:
  Select Planning > Tour planning.

Important Text Segments

**NOTE**

Important text sections have a blue background colour and include the comment *NOTE.*
Accessing FleetBoard Logistics Management

System Requirements

In order to be able to use the FleetBoard services in an optimal manner, FleetBoard recommends to fulfil the following system requirements (as minimum requirements):

- Microsoft Windows PC with DualCore processor with a minimum clock frequency of 2 GHz
- Main memory (RAM) of at least 2 GB
- 1 GB free memory capacity in the user profile directory, as a minimum requirement
- Screen resolution of 1280 x 1024 or higher
- Internet access via DSL with a minimum data rate of 6 Mbps
- Browser: Mozilla Firefox 3.6.10 or higher or Microsoft Internet Explorer 8 or higher

The following network infrastructure ports have to be activated for FleetBoard:

- www.fleetboard.com/info/en
- archive.fleetboard.com/info/en
- webservices.fleetboard.com
- maps.nokia.com
- http port 80
- https port 443
- Java WebStart applications
- SOAP protocol
- http 1.1 protocol (when using a proxy server)
Initial Installation and Login

You can find the complete information required for the installation and the initial login on the following page of the FleetBoard home page:


On this page, you can also find a Quick Start Guide which guides you through the installation process.

Contacting FleetBoard Support

If you have further questions or require information on our products, please feel free to contact the FleetBoard support. The multilingual support answers service requests promptly and offers solutions for standard problems via phone from Monday to Saturday:

- For Germany:
  Phone: +49 69 95 30 73 74
- For Austria:
  Phone: +43 13 60 27 73 024
- For Switzerland:
  Phone: + 41 22 56 75 124
  or via e-mail: support@fleetboard.com

NOTE

On the start page of the FleetBoard portal, you can find a link to the currently valid system requirements. Here, you can check your system with regard to the recommended system requirements using a further link.
Chapter 1
General Operating Instructions

1.1 Starting FleetBoard Logistics Management ............................................. 14

1.2 Interface Structure .................................................................................... 15
  1.2.1 Menu Bar ........................................................................................ 16
  1.2.2 Components ................................................................................... 17
  1.2.3 Buttons ........................................................................................ 18

1.3 Basic Functions of the FleetBoard Logistics Management Client .......... 19
  1.3.1 Context Menu ................................................................................. 19
  1.3.2 Drag & Drop ................................................................................... 20
  1.3.3 Moving Columns ............................................................................ 20
  1.3.4 Show and Hide Columns ................................................................ 20
  1.3.5 Change the Column Width .............................................................. 21
  1.3.6 Sorting Data Sets in Tables ............................................................. 21
  1.3.7 Export ............................................................................................ 22
  1.3.8 Display Data in Mapping ............................................................... 22
  1.3.9 Request a Vehicle Position ............................................................. 23
  1.3.10 Send Messages to a Vehicle .......................................................... 23
  1.3.11 Querying Information on FleetBoard ............................................ 24
1.1 Starting FleetBoard Logistics Management

To start FleetBoard Logistics Management, proceed as follows:

1. Enter the following address into the address line of your browser: 
   This will call up the FleetBoard homepage.

2. Enter your fleet, your user name, and your password. Your FleetBoard team or your fleet administrator will provide this data.

3. Click Login.

4. Select the Logistics Management service.
   After starting the service, the login window of the Logistics Management Client is displayed.

5. Enter the fleet, user, and password and click Login.
   Now, you can start working with FleetBoard Logistics Management.

The Logistics Management Client is a Java-based program. No browser is required for its use.
1.2 Interface Structure

The user interface of the Logistics Management Client is set up as follows:

- The menu bar serves to navigate the user interface and to call general functions.
- The components Templates, Planning, Info board, Latest infos, Search, and Mapping with various tabs.
- Various buttons in different windows
- Filter on each tab
### 1.2.1 Menu Bar

The menu bar contains the following functions:

<table>
<thead>
<tr>
<th>Menu Bar</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File &gt; Exit</strong></td>
<td>Exits the Logistics Management Client.</td>
</tr>
<tr>
<td><strong>View &gt; Templates</strong></td>
<td>Here, you will get to the <em>Templates</em> component, which allows you to create, edit, and delete templates for Logistics Management.</td>
</tr>
<tr>
<td><strong>View &gt; Planning</strong></td>
<td>Here, you will get to the <em>Planning</em> component, which allows you to plan orders and tours, for instance, and to assign them to vehicles.</td>
</tr>
</tbody>
</table>
| **View > Info board** | Here, you will get to the *Info board* component, which enables you to monitor the processing of current orders and tours.  
In the scope of the *Messaging* service, you can send text messages and address messages to the vehicles from here. |
| **View > Latest infos** | Here, you will get to the *Latest infos* component, which displays the messages that have been sent within the past 24 hours by any of your vehicles.  
This component shows messages which were sent from the vehicle respectively driver, such as position messages, read and receive confirmations, text messages, and status messages. |
| **View > Search** | Here, you will get to the *Search* component, which enables you to search for data which was exchanged between the dispatch office and the driver/vehicle. |
| **View > Mapping** | Here, you will get to the *Mapping* component, which makes the digital road map of the entire global road network available to you, for instance to plan routes, display routes of tours, or to search for arbitrary addresses and points of interest. |
### 1.2.2 Components

The various components are displayed according to the personal settings of the user. By default, the following components are displayed:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View &gt; Add views</td>
<td>Here, you can add further tabs to a component and combine them as you like. To restore the original view, select View &gt; Reset current view.</td>
</tr>
<tr>
<td>View &gt; Administration</td>
<td>Here, you will get to the Administration area, which allows you to create and edit Areas.</td>
</tr>
<tr>
<td>Settings &gt; System settings</td>
<td>In this section, you can make system settings (e.g. installation directory, log files, or locales).</td>
</tr>
<tr>
<td>Help</td>
<td>The help function provides information on the version and support, as well as links to the help and the start page of the FleetBoard Web site.</td>
</tr>
</tbody>
</table>
1.2.3 Buttons

The Templates tab accommodates the following buttons:

- Creates a new template.
- Opens the selected template.
- Copies the selected template.
- Deletes the selected template.
- Allows you to create a dispatch data set from the selected template.

The Dispatch data tab accommodates the following buttons:

- Creates a new dispatch data set.
- Lets you edit the selected data set.
- Copies the selected dispatch data set.
- Deletes the selected dispatch data set.
- Enables you to assign dispatch objects to dispatch data sets and delete links.
- Allows you to create a template from the selected data set.

The Vehicles tab accommodates the following buttons:

- Allows you to send tours to a vehicle.
- Allows you to determine a time stamp defining when a tour is sent to a vehicle.
- Enables you to complete tours manually.
- Allows you to change the planning of tours or orders.

**NOTE**

The number of buttons on the Vehicles tab varies, according to the fact whether you have booked the Logistics or Messaging service.
Enables you to send message to vehicles.
Enables you to send address messages to vehicles.
Enables you to send position requests to vehicles.

1.3 Basic Functions of the FleetBoard Logistics Management Client

1.3.1 Context Menu

In many sections of the client, you can use the context menu to quickly access important functions.
A right mouse-click on the user interface opens the context menu.
1.3.2 Drag & Drop

In many sections of the *Planning* and *Vehicles* tabs, you can work with drag & drop. For instance, you can assign an order to a tour via drag & drop (as long as the order fits into the structure of the tour). You can also drag a tour from the *Planning* tab to a vehicle on the *Vehicles* tab.

**NOTE**
This function is available in the *Templates*, *Planning*, and *Info board* components.

1.3.3 Moving Columns

You can move the table columns to any position you want. To do this, keep the left mouse button pressed and move the column header to the desired position. In this way, you can have those columns displayed in the first part of the table which you consider most important for your work.

You can move tabs in the same way or allocate them to a second monitor.

1.3.4 Show and Hide Columns

You can show or hide table columns.

Right-click on the table which contains the columns you want to hide.

The context menu is displayed.
To hide the column which your mouse pointer is just pointing to, select the *Hide column* option.

To hide another column, select the *Hide column >* option and then select the title of the column which you want to hide.

To show another column again, select the *> Hide column>* option with the right mouse button and then select the title of the column which you want to show.

### 1.3.5 Change the Column Width

In many places you can modify the width of a tab or of a table column. Move the mouse pointer to the separating line between the tabs or columns until the mouse pointer changes its appearance and drag the objects to the desired width.

### 1.3.6 Sorting Data Sets in Tables

FleetBoard presents data in the form of tables. To sort a table, click on the header of the column you choose to sort the data sets.

The table will now be sorted according to the selected column. Moreover, a little arrow is displayed which shows the current sorting direction.

Example:

The arrow next to the driver name indicates the sorting direction.

- **Arrow pointing upward ▲**: sorting in upward direction
- **Arrow pointing downward ▼**: sorting in downward direction
- **Column without arrow**: default sorting

The default sorting depends on the corresponding table and is displayed via an arrow pointing to the corresponding column.
1.3.7 Export

You can export data and access this data locally from your computer. You can then edit the data, for instance with Microsoft Excel. To export data, proceed as follows:

1. Select the table you wish to export. The filter function allows you to influence the contents of the table.

2. Click the Export as CSV button.

   The Save file as dialogue box is opened.

3. Please specify where you wish to save the exported files.

4. Click Save.

   The data will be saved as a .cvs file. You can now open the file in Microsoft Excel, for instance, and edit it there.

**NOTE** You can only export complete tables. Prior to that, however, you can influence the structure of the table by using the filters.

1.3.8 Display Data in Mapping

In Mapping, you can display the positions of the vehicles on a map. Proceed as follows to view position data of Logistics Management:

1. Open the Mapping component.

2. Go to the Vehicles tab.

3. Select a vehicle.

4. In the filter, select which data sets are to be displayed and which time period you want to view.

   The filtered data sets will now be displayed on the map.

**NOTE** The documentation for the Mapping module instructs you in detail how to work with Mapping.
1.3.9 Request a Vehicle Position

1. Select the *Vehicles* tab.

2. Select the vehicle for which you want to send a position request. Via CTRL + click you can select several vehicles simultaneously.

3. Click *Position request*.

The positions of the selected vehicles will now be queried.

The position request will be displayed as a message on the *Info board* tab.

When the vehicles transfer their positions, messages of the type *Position* will be received and displayed on the *Latest infos* and *Info board* tabs.

1.3.10 Send Messages to a Vehicle

With this function, you can send a simple text message to the vehicle.

1. Select the *Vehicles* tab.

2. Select the vehicle to which you wish to send a message. Via CTRL + click you can select several vehicles simultaneously.

3. Click the button *Send message*.

The *Send message* dialogue box will be displayed.

4. Under *Subject*..., enter your message.

5. If required, you can enter an additional text in the field below.

6. Click *Send*.

The message will now be sent.

It will be displayed in the messages list on the *Latest infos* tab.
1.3.11 Querying Information on FleetBoard

- Online help
  You can start the online help via Help > Help.

- Support
  You can call the contact address, as well as an e-mail template to contact FleetBoard Support Help > Support.

- Website
  You can call the FleetBoard Website via Help > Website.

- Version information
  You can find information on the Logistics Management service under Help > About.
Chapter 2
Planning Orders and Tours

2.1 General Information on How to Plan Orders and Tours ......................... 26

2.2 How to Create and Administer Orders and Tours ...................................... 27
  2.2.1 Create a New Order .................................................................................. 28
  2.2.2 Create a New Tour .................................................................................. 30
  2.2.3 Edit a Dispatch Data Set Subsequently .................................................. 31
  2.2.4 Copy a Dispatch Data Set ...................................................................... 32
  2.2.5 Delete a Dispatch Data Set ..................................................................... 32

2.3 Assign Orders to Tours .................................................................................. 33
  2.3.1 Assign an Order to a Tour ................................................................. 33
  2.3.2 Change the Sequence of the Orders of a Tour ...................................... 35
  2.3.3 Resetting the Assignment of an Order ................................................. 36

2.4 Assign Orders and Tours to Vehicles ............................................................ 36
  2.4.1 Assign a Tour to a Vehicle ................................................................. 36
  2.4.3 Send a Tour .......................................................................................... 40
  2.4.4 Scheduling Tours ............................................................................... 41
  2.4.5 Change the Send Time of a Scheduled Tour ....................................... 41
  2.4.6 Unscheduling a Tour—Reset the Schedule of a Tour ......................... 42
  2.4.7 Monitoring an Order ............................................................................ 42
2.1 General Information on How to Plan Orders and Tours

The Planning component allows you to administrate orders and other dispatch data and to distribute them to tours and vehicles.

**NOTE**
Dispatch data sets are data sets which can be sent to a vehicle. These data may include different order types (e.g. loading order, unloading order, return order), order and send positions, as well as package data. You can individually adapt or extend the dispatch objects which are available for your fleet. To do this, please contact the FleetBoard Support.

In a first step, orders are created (*Dispatch data* tab).

In a second step, these orders are then combined to tours (*Planning* tab).

Finally, the orders and tours are assigned to individual vehicles (*Vehicles* tab).

**NOTE**
In the default configuration, you can only assign order to vehicles within a tour. If you want to assign orders to vehicles directly (so-called direct orders), the configuration of your vehicles has to be modified. For this purpose, please contact the FleetBoard Support.
2.2 How to Create and Administrate Orders and Tours

In Logistics 3.0, orders and tours are also referred to as dispatch data. You can administrate dispatch data on the Dispatch data tab. This tab contains the following sections:

- The list shows orders which have not yet been assigned to any tour.
- In the Filter area above the list, you can set filters if you wish to display specific data sets only:
  - If you only want to display dispatch data of a specific type, select the corresponding entry under Type. If you want to view all order types, select All. By default, only the types Tour, Loading order, Unloading order, and Order position are available. You can have further types configured by FleetBoard Support.
  - If you only want to display data with a specific quick info, enter the corresponding terms under Quick info.
If you only want to display data which were created during a specific time period, check the *Created between* option and enter the dates and time into the corresponding input fields.

### 2.2.1 Create a New Order

**NOTE** With the example of an order, the following section describes how to create a dispatch data set. Packages, loading and unloading orders are created in the same way.

To create a new order, proceed as follows:

1. On the *Dispatch data* tab, click the *Create dispatch data set button*.
   
   ![Type of dispatch object](image)
   
   The *Type of dispatch object* dialogue box will be opened.

2. Select an order type.
This will open the input mask for the order form. In the form, enter all the data necessary for completing the order.

**NOTE**

According to the type of dispatch object which you want to create, this form may contain different input fields.

It is possible to create various customised forms. For more information, please contact the FleetBoard Support.

3. Fill in the form with the appropriate data.

If you wish to perform georeferencing for an address:

4. Enter at least a city or a post code. For cities in foreign countries, you have to enter the appropriate country code in the *Country* field.

5. Click *GeoRef*.

FleetBoard will then determine the geographical coordinates of the address you have entered and automatically insert the geographical longitude and latitude into the *Latitude/longitude* fields. The geographical coordinates will be sent to the vehicle along with the order. The driver will then be able to transmit the address directly to the navigation system.

If FleetBoard detects several possible destinations for the data you have entered, the *Georeferencing* window will be opened.

Select a destination and click *OK*. 
6. Click Mapping to have the address displayed in Mapping.

7. If you want to check whether the vehicle is performing the order as has been scheduled, click the Monitoring button. The Monitoring dialogue box will be opened. The options provided by this dialogue box are explained in Section Monitoring an Order, Page 42.

**NOTE**

There may be no Monitoring button in your order forms. If you require the monitoring function, please contact the FleetBoard Support department.

8. If you want to be notified when the order has been received by the vehicle, check Request receipt confirmation.

9. If you want to be notified when the order has been read by the driver, check the Request read confirmation option.

**NOTE**

There may be no Read confirmation or Receipt confirmation checkbox in your order forms. If you require these functions, please contact the FleetBoard Support department.

10. Then, click the Save button. The new order will be displayed in the list. When saving, FleetBoard automatically assigns a consecutive ID number to each new dispatch data set (ID). As a result, each dispatch data set can be identified unambiguously. You can find the ID in the ID column in the order list.

### 2.2.2 Create a New Tour

1. On the Dispatch data tab, click Create dispatch data set...

The Type of dispatch object dialogue box will be opened.

2. Select a tour under Type.
This will open the input mask for the tour form. In the form, you can capture all the data required to complete the tour.

3. In the Name field, enter a descriptive designation of the tour.

4. Optionally, you can also enter details on the tour in the Comment field.

5. If you want to be notified when the tour has been received by the vehicle, check Request receipt confirmation control box.

6. If you want to be notified when the tour has been read by the driver, check Request read confirmation control box.

7. Click Save.

The tour will then be displayed with the data you have entered in the list on the Dispatch data tab. FleetBoard additionally assigns consecutive ID numbers to each tour (ID), so that each tour is marked unambiguously.

### 2.2.3 Edit a Dispatch Data Set Subsequently

Double-click the order or the tour you wish to edit.

OR:

Select the order or the tour you wish to edit and click the button Edit dispatch data set...
The data set form is opened. You can edit it now.

Click the Save button to save your changes.

**NOTE** If you click the icon in the data set form, additional information will be displayed. If you wish to hide this additional information again, click the icon.

### 2.2.4 Copy a Dispatch Data Set

1. On the *Dispatch data* or *Planning* tab, select the order or the tour you want to duplicate.

2. Click the *Copy dispatch data set* button.

A copy of the order or of the template will be displayed in the list under *Dispatch data* respectively *Planning*. You can edit it now.

**NOTE** If you copy a tour to which orders have already been assigned, the complete tour tree including the orders will be copied.

### 2.2.5 Delete a Dispatch Data Set

1. On the *Dispatch data* or *Planning* tab, select the order or the tour you want to delete.

2. Click the *Delete dispatch data set...* button.

You will receive a warning message asking you whether you really want to delete the data set.

**NOTE** If you delete a tour to which orders have already been assigned, the complete tour tree including the orders will be deleted!

3. If you are sure that you want to delete this dispatch data set, confirm the message by clicking *Yes*.

The dispatch data set will be deleted.
2.3 Assign Orders to Tours

Navigating the Tour List

The list of tours on the Planning tab contains tours or orders which have already been allocated to a tour. By clicking the + or – symbol next to the tour you can fade in or out the corresponding orders.

The meaning of the symbols in the list of tours is explained under Section Important Symbols, Page 86.

2.3.1 Assign an Order to a Tour

With the help of this function, you can assign various orders to tours on the Dispatch data tab. You can assign any number of orders to a tour.

1. On the dispatch data tab, click the Plan order button.

The Assign window is opened.

2. In the Dispatch data list, select the tour to which you want to assign orders.

3. Click the arrow buttons between the two lists which point from left to the right.
4. Select a type under *Structure* and then click *OK*.

**NOTE**

Structures are used to support different cases of application or transport types within your fleet. If you carry out both long-distance and local transports with your fleet, you can use different structures for each traffic type. This means that the form for the loading order for long-distance traffic can have contents which differ from the load order form for local transport. If you have any further questions, please contact the FleetBoard Support.

5. The tour will then be displayed in the *Logistics* list.

6. Select the tour.

7. In the *Dispatch data* list, select the order which you want to assign to the tour.

8. Click the arrow buttons between the two lists which point from left to the right.
The order is now displayed in the *Logistics* list and is assigned to the selected tour.

9. If you are unable to see the order below the tour, click the + symbol next to the tour symbol to “open” the tour.

### 2.3.2 Change the Sequence of the Orders of a Tour

You can change the sequence of the orders within a tour via drag & drop. This may be necessary if you wish to subsequently create a new order and assign it to a tour. Proceed as follows:

1. Select the order which you want to move.

2. Use the mouse to drag the order to the desired position. The mouse button has to be pushed when doing this.
2.3.3 Resetting the Assignment of an Order

You can reset the assignment of an order to a tour.

1. On the Dispatch data tab, click the Plan order button. The Assign window is opened.

2. In the Logistics list, select the order in the right section of the window for which you want to reset the assignment.

3. Click the arrow buttons between the two lists which point from left to the right. The order will then be displayed in the Dispatch data list to the left.

**NOTE** The assignment can also be reset by performing a drag & drop from the Logistics to the Dispatch data tab.

2.4 Assign Orders and Tours to Vehicles

2.4.1 Assign a Tour to a Vehicle

1. On the Planning tab, click the Dispatch button. The Logistics dialogue box is opened.

2. Select the tour in the Logistics list which you want to assign to the vehicle.

3. Select the vehicle in the Vehicles list to the right to which you want to assign a tour.

4. Click the arrow buttons between the two lists which point from left to the right.
The tour is now assigned to the vehicle. If you are unable to see the trip below the vehicle, click the + symbol next to the vehicle symbol to “open” the view.

**NOTE**
You can only assign a tour to a vehicle if this vehicle has been configured for the selected tour type. If this is not the case, the vehicle will only be displayed in dimmed form and you will be unable to assign the selected tour to it.

**NOTE**
You can also assign a tour from the *Logistics* tab to a vehicle on the *Vehicles* tab via drag & drop.
Navigating the Vehicles List

The **Vehicles list** contains the vehicles of your fleet assigned to vehicle groups.

- You can open a vehicle group by clicking the + symbol next to this group. The vehicles belonging to this group are displayed.
- If a + symbol is displayed next to one of the vehicles, it means that a tour has already been assigned to this vehicle. Click the + symbol to display the tour.
- A + symbol next to the tour means that orders are assigned to this tour. Click the + symbol to display the orders.

The meaning of the symbols in the list of vehicles is explained under Section Important Symbols, Page 86.
### 2.4.2 Reset the Assignment of a Tour

You can reset the assignment of a tour to a vehicle.

1. On the **Planning** tab, click the **Dispatch** button.

The **Logistics** dialogue box is opened.

2. In the **Vehicles** list, select the tour in the right section of the window for which you want to reset the assignment.

3. Click the arrow buttons between the two lists which point from left to the right.

The tour will then be displayed again in the **Logistics** list to the left.

**NOTE**

The assignment can also be reset by performing a drag & drop from the **Vehicles** to the **Logistics** tab.
2.4.3 Send a Tour

Once you have created a tour and assigned it to a vehicle, you can send the data to the vehicle to transfer the tour to the driver. To do this, proceed as follows:

1. Select the tour which you want to send on the Vehicles tab.
2. Click the Send button.
3. The Transmission of dispatch data dialogue box will be opened.
4. Click the Send button. (You do not have to select the displayed data set additionally.)

The tour is now transferred to the vehicle. You can now find the tour in the Info board component on the Vehicles tab under the vehicle to which you have sent the tour.
2.4.4 Scheduling Tours

If you have already completed the data of a tour, but do not wish to transmit it to the corresponding vehicle immediately, you can schedule the time when the data is to be sent. To do this, proceed as follows:

1. Select the tour which you want to schedule on the Vehicles tab.
2. Click the Schedule button.
3. The Schedule input mask will be called.
4. Fill in the date and time fields to determine the send time.
5. Click the Schedule button.

The tour is now displayed in the vehicle list and is assigned to a vehicle there. The tour, however, will not be sent to the vehicle before the scheduled send time.

If a corresponding input field is provided in the form of the tour (depends on the configuration), the scheduled send time should be entered into this field.

2.4.5 Change the Send Time of a Scheduled Tour

1. On the Vehicles tab, select the tour for which you want to change the send time.
2. Click the Schedule button. Alternatively, you can select the context menu with a right-click and then click Schedule... .
3. Fill in the date and time fields to change the send time.
4. Click the Schedule button.
2.4.6  Unschedule—Reset the Schedule of a Tour

1. Select the trip in the vehicle list.
2. Open the context menu with a right-click and then click on Unschedule...

NOTE
This function is exclusively available via the context menu of the tour—not via a button.

When carrying out the Unschedule function, no additional window will be displayed and no confirmation message will be sent, either.

The send time will be removed from the input field in the tour form again.

2.4.7  Monitoring an Order

NOTE
To configure monitoring, your fleet has to be configured correspondingly. If you have any questions, please contact the FleetBoard Support.

2.4.7.1  Arrival Monitoring

You can check whether an order is carried out on time. To do this, enter the scheduled time of arrival. The navigation system then computes the expected time of arrival. In the case of a delay, you will receive a corresponding message. You can forward this message automatically by e-mail or SMS.

2.4.7.2  Area Monitoring

In the Mapping module, you can define reference areas, while in the Logistics Management service you can monitor the entry or exit of a vehicle into/from a reference area. If you define a reference area around a loading point, for instance, you can determine that you will always receive a message as soon as the vehicle enters the reference area. This message can be forwarded automatically to the loading point in order to announce that a vehicle is to arrive soon. This makes it easier to efficiently plan loading and unloading times.
2.4.7.3 How to Configure Arrival or Area Monitoring

To configure monitoring options, proceed as follows:

1. Open the order form of the order whose execution you want to monitor.

2. Click GeoRef.

The geographical coordinates are automatically entered under Longitude/Latitude.

3. Click the Monitoring button.

**NOTE**

If you do not see the Monitoring button, your system is possibly not configured to activate the monitoring function. If you require the Monitoring function, please contact the FleetBoard Support department.

The Monitoring dialogue box will be opened.

4. If you want to forward messages about the delay of a vehicle or referring to the entry or exit of a vehicle into/from a specific area:
   Specify the E-mail address and/or the SMS number to which you want to forward the message.
5. Under *Time zone*, select the time zone in which you want to monitor the order (the default setting is the home location of the fleet). FleetBoard will then convert the time data from the monitoring function to the selected time zone. This feature is useful if your vehicles are located in another time zone than you are.

**Example:** One of your vehicles is currently in Portugal. Portugal lies in the time zone Western European Summer Time. If you select Western European Summer Time as the time zone, all time messages sent from and sent to this vehicle will be converted to the Western European Summer Time. This means you do not have to make the time conversion yourself.

6. As the *Planned time of arrival* of the vehicle, select a date and time.

---

**NOTE** You can also enter several e-mail addresses or SMS receivers. Use the semicolon ";" as a separator.

Arrival Monitoring

If you want to check whether your vehicle will arrive on time:

7. Check the *Delay* control box.

8. As the *Latest time of arrival* of the vehicle, select a date and time.

You will then be informed if the navigation system of the vehicle computes that the vehicle cannot possibly arrive at the latest arrival time specified.
Area Monitoring

If you want to monitor the entry or exit of a vehicle into/from a reference area:

9. Select the reference area you want to monitor.

10. Alternatively, check the Radius control box and specify which radius of the order address you wish to monitor.

11. Under Validity period, specify how many minutes before or after the planned arrival time of the vehicle a message will be sent whenever the vehicle enters or exits the monitored area. This means that area monitoring will only be activated during the time period determined via the validity period.

12. Check the Area entry and/or Area exit box. You will then obtain a vehicle message whenever the vehicle enters and/or exits the monitored area.
**Example**: The vehicle is to arrive at the destination on December 29, 2011 at 03:00 p.m. The reference area Offenbach was selected. A validity period of 60 minutes was selected.

With these settings, messages will be sent to the dispatch office between 02:00 p.m. and 04:00 p.m. as soon as the vehicle enters or exits the reference area Offenbach.

13. After having entered the required monitoring data, click *Create*.

Depending on the available monitoring information, the *Monitoring* button in the order form may be displayed in one of the following colours:
<table>
<thead>
<tr>
<th>Button</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grey button</td>
<td>No monitoring has been configured.</td>
</tr>
<tr>
<td>Button with green frame</td>
<td>Valid monitoring options have been configured.</td>
</tr>
<tr>
<td>Button with red frame</td>
<td>Monitoring options have been configured, but the pick-up address has been changed afterwards. This means that FleetBoard cannot provide valid monitoring data. Click the GeoRef button in the order form in order to create a new grid reference for the address.</td>
</tr>
</tbody>
</table>
Chapter 3
Working with Templates

3.1 General Information on Templates ................................................................. 50
3.2 Create a New Template ............................................................................. 50
3.3 Create a Template from an Existing Order ............................................. 51
3.4 Create a New Order with the Help of a Template ..................................... 51
3.1 General Information on Templates

Templates make it possible to process identical or similar orders very quickly. You can administrate templates in the Templates component.

NOTE All above-mentioned functions are also available via the context menu in the table which you can fade in via a right mouse-click.

3.2 Create a New Template

1. On the Templates tab, click the Create template button.

2. The Type of dispatch template dialogue box will be opened.

3. Perform the steps required to create a new order template. If you are not sure how to create a new order, refer to Section Create a New Order, Page 28.

4. Save the template.

The template will then be displayed in the list of templates.

NOTE You can open a selected template or copy it.
3.3 Create a Template from an Existing Order

You can use an existing order or tour to create a template. In this case, you do not have to fill in the complete template form from scratch.

1. On the Dispatch data tab, select the dispatch data set you want to use to create a template.

2. Click the Create dispatch data set... button.

The template will then be displayed in the list of templates. You can open, edit, supplement, and save the template after double-clicking it.

**NOTE** You can also drag an order from the Dispatch data tab to the templates list by means of drag & drop.

3.4 Create a New Order with the Help of a Template

With the help of a template, you can create a new dispatch data set very quickly.

1. Select the template you wish to use to create a new dispatch data set.

2. Click the Create dispatch data set from template... button.

The new dispatch data set will then be displayed on the Dispatch data tab. It will already contain data which is included in the template. You can open, edit, supplement, and save the data set after double-clicking it.

**NOTE** You can also drag a template from the Dispatch templates tab to the order list by means of drag & drop.
3.5 Delete Templates

1. Select the template you want to delete.
2. Click the *Delete dispatch data set...* button. 
   You will receive a warning message asking you whether you really want to delete the data set.
3. If you are sure that you want to delete the template, confirm the message by clicking the *Yes* button.
Chapter 4  
Messaging

4.1 General Information on the Messaging Service .................................. 54
4.2 Info Board .......................................................................................... 55
4.3 Send Message to Vehicle ................................................................. 56
4.4 Send Address to Vehicle ................................................................. 58
4.5 Display Messages ............................................................................. 61
   4.5.1 How to Read the Messages List .................................................. 62
   4.5.2 Various Message Types .............................................................. 63
4.6 Open the Detail View of a Message .................................................. 65
4.7 Latest Infos and Search .................................................................... 66
4.1 General Information on the Messaging Service

On the *Info board* component, you can use the client functions of the Messaging service.

With the *Send message* function, you can send a free text message to one or several vehicles.

The *Send address* function allows you to send an address along with the geographical coordinates to the driver of a vehicle for direct export into navigation.

When using the navigation system, automatic events can be created by the DispoPilot and be displayed in the Logistics Management Client. You will, thus, be informed when the navigation is started, the vehicle reaches the destination, or the navigation system is no longer used.

**NOTE**

The *Templates* and *Planning* components are not included in the *Messaging* service. They will only be available to you if you have booked the *Logistics* service.

The function of the *Mapping* component is not included in the *Messaging service*. It will only be available to you if you have booked the *Mapping* service.

For this purpose, please contact the FleetBoard Support.

In the *Latest infos* component, you can display incoming and outgoing messages for the past 24 hours. For more information, please refer to Section *Latest Infos*, Page 77.

The *Search* component allows you to search for incoming and outgoing messages. For more information, please refer to Section *Search for Messages*, Page 79.
4.2 Info Board

On the *Info board* tab, you can read messages sent from vehicles and, thus, monitor the performance of current transport orders.

Moreover, text messages and address messages are displayed, which you have sent to the vehicles, as well as automatically created receive and read confirmations sent from the vehicles.

The component is structured, as follows:

- The **Vehicles list** shows the vehicle groups and vehicles of your fleet. If you have selected a vehicle group, only messages referring to this vehicle group will be displayed in the messages list to the right. If you have selected a single vehicle, only messages referring to this vehicle will be displayed.

- In the **Messages list** you can find messages sent from your vehicles and messages which you have sent to your vehicles. A double-click on
a message opens the detail view of the message with additional information.

- The **Messages filter** serves to configure which message types will be displayed.

**NOTE**
The Messages filter is a display filter, i.e. it serves to customise the already existing display of messages individually to your requirements. It does not control the loading of additional messages from the server.

### 4.3 Send Message to Vehicle

With the *Send message* function, you can send a text message to one or several vehicles. You can also request a receive or read confirmation for this message.

To do this, proceed as follows:

1. In the toolbar of the vehicles list, click the *Send message* button.

The *Send message* dialogue box is opened:
2. Click the button ...

The Vehicle selection dialogue box is opened:

3. Select a vehicle group or one or several vehicles as addressees from the list and click Select.

The Vehicle selection dialogue box will be closed.

4. Enter a text message in the input field.

**NOTE**
A text message can have a length of up to 1000 characters.

5. If you want to be notified when the message has been received by the vehicle, check the Receive confirmation control box.

6. If you want to be notified as soon as the driver has read the message, check the Read confirmation control box.

7. Click Send.

You have sent a message to one or several vehicles.
4.4 Send Address to Vehicle

The *Send address* function allows you to send an address along with the geographical coordinates to the driver of a vehicle for direct export into navigation.

**NOTE** The *Send address* function is only available to you in the context of the *Messaging* service. If you require this function in the scope of the *Logistics* service, please contact the FleetBoard Support.

The address message can contain information on the customer, an address, and a note.

When using the navigation system, automatic events can be created by the DispoPilot and be displayed in the Logistics Management Client. You will, thus, be informed when the navigation is started, the vehicle reaches the destination, or the navigation system is no longer used.

You can also request a receive or read confirmation for this message.

To send an address message, proceed as follows:

1. Select a vehicle from the vehicle list to which you want to send an address message.
2. Click the *Send address* button.

The *Send address* dialogue box is opened:
3. Enter a *Customer number* and, optionally, a *Customer.*

4. Enter an *Address.* Also enter at least a city or a post code. For cities in foreign countries, you have to enter the appropriate country code.

If you wish to perform georeferencing for an address:

5. Click *Georeferencing.*

FleetBoard will then determine the geographical coordinates of the address you have entered and automatically insert the geographical longitude and latitude in the fields *Longitude/latitude.* The geographical
coordinates are sent to the vehicle along with the address message. The driver will then be able to transmit the address directly to the navigation system.

If FleetBoard detects several possible destinations for the data you have entered, the Georeferencing window will be opened.

![Georeferencing Window](image)

Select a destination and click **OK**.

6. To display an address in the Mapping service, click **Mapping**.

**NOTE**

You can then display an address in the **Mapping** service, provided that you have booked the **Mapping** service.

For this purpose, please contact the FleetBoard Support.

7. If you want to be informed on the routing process, check the **Notification when navigation system is used** control box.

**NOTE**

When using the navigation system for a transferred address, the following events can be automatically created by the DispoPilot:

- Navigation system has been started
- Destination has been reached
- Navigation has been cancelled
8. If required, enter a message to be sent to the driver under *Note*.

9. If you want to be notified when the address message has been received by the vehicle, check the *Receive confirmation* control box.

10. If you want to be notified as soon as the driver has read the address message, check the *Read confirmation* control box.

11. Click *Send*.

You have sent an address message to a vehicle.

### 4.5 Display Messages

To display messages sent from specific vehicle groups or individual vehicles in the messages list, proceed as follows:

1. In the vehicle list, select a fleet 🔥, a vehicle group 🚗, or a vehicle 🚗.
   
   - If you have selected the complete fleet or a vehicle group, only the last message sent by the vehicles will be displayed in the messages list.
   
   - If you have selected a vehicle, all related messages will be displayed.

2. You can filter the messages list by means of the messages filter. For instance, you can have only text messages displayed.

<table>
<thead>
<tr>
<th>Filter</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Sent</td>
<td>Activity</td>
<td>Text message</td>
<td>Position</td>
</tr>
<tr>
<td></td>
<td>Received</td>
<td>Event</td>
<td>Confirmation</td>
<td></td>
</tr>
</tbody>
</table>
### How to Read the Messages List

You can align the columns individually and shift them. For this reason, the messages list may differ from the list shown in this manual.

<table>
<thead>
<tr>
<th>No.</th>
<th>Quick info</th>
<th>Driver</th>
<th>Creation date</th>
<th>Position</th>
<th>Ignition</th>
<th>Engine</th>
<th>Content</th>
<th>Odometer reading</th>
<th>Speed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Position</td>
<td>Unknown driver</td>
<td>19.10.2012 11:30:21</td>
<td>AK Stuttgart (D-78127) E 2.5 m.</td>
<td>On</td>
<td>Off</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Position</td>
<td>Unknown driver</td>
<td>19.10.2012 11:30:21</td>
<td>AK Stuttgart (D-78127) E 2.5 m.</td>
<td>On</td>
<td>Off</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Position</td>
<td>Unknown driver</td>
<td>19.10.2012 11:30:21</td>
<td>AK Stuttgart (D-78127) E 2.5 m.</td>
<td>On</td>
<td>Off</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Driver message</td>
<td>Unknown driver</td>
<td>19.10.2012 11:30:21</td>
<td>AK Stuttgart (D-78127) E 2.5 m.</td>
<td>On</td>
<td>Off</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Position</td>
<td>Unknown driver</td>
<td>19.10.2012 11:30:21</td>
<td>AK Stuttgart (D-78127) E 2.5 m.</td>
<td>On</td>
<td>Off</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Position</td>
<td>Unknown driver</td>
<td>19.10.2012 11:30:21</td>
<td>AK Stuttgart (D-78127) E 2.5 m.</td>
<td>On</td>
<td>Off</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Position</td>
<td>Unknown driver</td>
<td>19.10.2012 11:30:21</td>
<td>AK Stuttgart (D-78127) E 2.5 m.</td>
<td>On</td>
<td>Off</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Position</td>
<td>Unknown driver</td>
<td>19.10.2012 11:30:21</td>
<td>AK Stuttgart (D-78127) E 2.5 m.</td>
<td>On</td>
<td>Off</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Position</td>
<td>Unknown driver</td>
<td>19.10.2012 11:30:21</td>
<td>AK Stuttgart (D-78127) E 2.5 m.</td>
<td>On</td>
<td>Off</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Position</td>
<td>Unknown driver</td>
<td>19.10.2012 11:30:21</td>
<td>AK Stuttgart (D-78127) E 2.5 m.</td>
<td>On</td>
<td>Off</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Driver message</td>
<td>Unknown driver</td>
<td>19.10.2012 11:30:21</td>
<td>AK Stuttgart (D-78127) E 2.5 m.</td>
<td>On</td>
<td>Off</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Position</td>
<td>Unknown driver</td>
<td>19.10.2012 11:30:21</td>
<td>AK Stuttgart (D-78127) E 2.5 m.</td>
<td>On</td>
<td>Off</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Position</td>
<td>Unknown driver</td>
<td>19.10.2012 11:30:21</td>
<td>AK Stuttgart (D-78127) E 2.5 m.</td>
<td>On</td>
<td>Off</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Position</td>
<td>Unknown driver</td>
<td>19.10.2012 11:30:21</td>
<td>AK Stuttgart (D-78127) E 2.5 m.</td>
<td>On</td>
<td>Off</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Position</td>
<td>Unknown driver</td>
<td>19.10.2012 11:30:21</td>
<td>AK Stuttgart (D-78127) E 2.5 m.</td>
<td>On</td>
<td>Off</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Position</td>
<td>Unknown driver</td>
<td>19.10.2012 11:30:21</td>
<td>AK Stuttgart (D-78127) E 2.5 m.</td>
<td>On</td>
<td>Off</td>
<td>0</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

- The first column contains symbols which give hints to the message type transferred. Please refer to Section Various Message Types, Page 63 and Section Important Symbols, Page 86.
- The second column shows whether the messages is a message sent or received.
  - Message which was sent to the central dispatch office
  - Message which was received by the central dispatch office
- The third and fourth column contain information as to whether the message has already been received by the vehicle and been read by the driver. Please refer to Section Various Message Types, Page 63.
- The *Quick info* column provides information on the message type.
- In the *Vehicle* column, you will find the vehicle identifier.
- In the *Driver* column, you will find the driver name or the driver ID.
The *Time of creation* column provides information on the transfer time of the message. If the vehicle is located in another time zone, the creation time of the message will be computed to the corresponding local time.

In the *Position* column, you will find information on the position of the vehicle at the time the message was sent.

**NOTE**

Messages marked by a * at the end indicate the last available position transferred by the vehicle to FleetBoard.

The next two columns provide information on the state of the ignition and of the engine: *ignition on/off* or *engine on/off*.

The *Context* column contains the reference object for messages sent from vehicles. For navigation events, for instance, this is the corresponding address message.

*Odometer reading* specifies the current odometer reading of the vehicle at the time the message was sent.

*Speed* is the current speed of the vehicle at the time the message was sent.

*Total consumption (l)* is the total fuel consumption of the vehicle at the time the message was sent.

*Fuel level (%)* is the fuel level of the vehicle at the time the message was sent.

*Total weight (t)* is the total weight of the vehicle at the time the message was sent.

### 4.5.2 Various Message Types

**Messages Sent from the Dispatch Office to the Vehicle**

- **Free text message**: Text message which was sent from the dispatch office to the driver of the vehicle. The first part of the message is displayed in the *Quick info* column. If you want to send such a message, please read Section Send Message to Vehicle, Page 56.
Address message 📨: Address message which was sent from the dispatch office to the driver of the vehicle. The customer name and the destination are displayed in the column Quick info. If you want to send such a message, please read Section Send Address to Vehicle, Page 58.

Message Sent from the Vehicle to the Dispatch Office 📨

- Free text message 📨: Messages which the driver formulates as free text and then sends to the dispatch office. The first part of the message is displayed in the Quick info column.

- Confirmation: Provides information whether a message was received by the vehicle 📨 or was read by the driver 📨.

- Automatic navigation events 📨: If active routing is used from an address message, the automatically created events Navigation system has been started, Destination has been reached, Navigation has been cancelled can be displayed here.
4.6 Open the Detail View of a Message

Double-click a message to open the detail view for this message. In the detail view, you can find more detailed information on the message.

**NOTE**

The detail view may vary in terms of the design and the information contained, according to the message type concerned.

![Properties of the dispatch object](image)

The *Navigation system has been started* message, which is automatically created by the DispoPilot, for instance, contains the following information:

- Address of the navigation destination, *Longitude/latitude* of the destination address,
- *Time* when the navigation was started
- *Expected time of arrival* at the destination
- *Duration* of the trip to the destination and *Distance* from the destination
- *Position* of the vehicle at the time the message was sent
- *Speed* of the vehicle at the time the message was sent

### 4.7 Latest Infos and Search

The *Latest infos* component allows you to view incoming and outgoing messages. As a maximum, the messages sent during the past 24 hours are displayed. You can find older messages in the *Search* component. For more information, please refer to [Section Latest Infos, Page 77](#).

The *Search* component allows you to search for incoming and outgoing messages. For more information, please refer to [Section Search for Messages, Page 79](#).
Chapter 5
Tracing Sent Tours and Orders

5.1 General Information on How to Monitor Orders and Tours .........................68

5.2 Info Board.......................................................................................................69
  5.2.1 Display Messages ....................................................................................70
  5.2.2 Open the Detail View of a Message .......................................................74
  5.2.3 Modify Data of Already Existing Orders...............................................74
  5.2.4 Rearrange Tours or Orders Sent.............................................................74
  5.2.5 Complete Orders and Tours Manually ..................................................75

5.3 Latest Infos .....................................................................................................77
5.1 General Information on How to Monitor Orders and Tours

On the *Info board* tab, you can check the status of current tours and orders. Moreover, you will gain an overview which messages have been sent and received by a vehicle.

The *Latest infos* component displays messages which your vehicles have sent since the Logistics Management Client was started. As a maximum, the messages sent during the past 24 hours are displayed.

The *Search* component allows you to search for tours and orders which have already been completed.
5.2 Info Board

On the *Info board* tab, you can read messages sent by vehicles and, thus, monitor the performance of current orders.

The component is structured, as follows:

- **Vehicles list**
- **Messages list**

In the **Vehicles and Tours lists**, you can select for which vehicles or tours you wish to display messages. You can open the vehicles list via the symbol and close it via the symbol.

- The **Vehicles list** shows the vehicle groups and vehicles of your fleet. If you have selected a vehicle group, only messages referring to this vehicle group will be displayed in the messages list to the right. If you have selected a single vehicle, only messages referring to this vehicle will be displayed. If you have selected a tour or an order, only messages referring to this tour or order will be displayed.
■ In the **Messages list** you can find messages sent from your vehicles and messages which you have sent to your vehicles. A double-click on a message opens the detail view of the message with additional information.

■ The **Messages filter** serve to configure which message types will be displayed.

**NOTE**
The Messages filter is a display filter, i.e. it serves to customise the already existing display of messages individually to your requirements. It does not control the loading of additional messages from the server.

### 5.2.1 Display Messages

On the **Vehicles** tab, you can select vehicles, tours, and orders, while in the right window the corresponding messages will be displayed.

1. Select the fleet 🚗, a vehicle group 🚗, a vehicle 🚗, a tour 🚗, an order 🚗, or another event (loading, unloading, etc.).

■ If you have selected the complete fleet or a vehicle group, only the last message sent by the vehicles will be displayed in the message list.

■ If you have selected a vehicle, an order, or a tour, all related messages will be displayed. For the current tours and orders—including position messages.

2. You can filter the message list by means of the message filter. For instance, you can have only position messages displayed.

![Filter](image)

Please refer to **Section Various Message Types, Page 72**.
5.2.1.1 How to Read the Messages List

**NOTE** You can align the columns individually and shift them. For this reason, the message list may differ from the list shown in this manual.

- The first column contains symbols which give hints to the message type transferred. Please refer to Section Various Message Types, Page 72 and Section Important Symbols, Page 86.

- The second column shows whether the messages is a message sent or received.
  - **Message which was sent to the central dispatch office**
  - **Message which was received by the central dispatch office**

- The *Quick info* column provides information on the message type.
  - In the scope of the fleet configuration, the column can be individually adapted, where required.

- In the *Vehicle* column, you will find the vehicle identifier.

- In the *Driver* column, you will find the driver name or the driver ID.

- The *Time of creation* column provides information on the transfer time of the message. If the vehicle is located in another time zone, the creation time of the message will be computed to the corresponding local time.

- In the *Position* column, you will find information on the position of the vehicle at the time the message was sent.

**NOTE** Messages marked by a * at the end indicate the last available position transferred by the vehicle to FleetBoard.

- The next two columns provide information on the state of the ignition and of the engine: ignition on/off or engine on/off.

- The *Context* column provides a quick info on the order or on the corresponding data set (tour, loading, unloading) to which the message refers.
- **Odometer reading** specifies the current odometer reading of the vehicle at the time the message was sent.

- **Speed** is the current speed of the vehicle at the time the message was sent.

- **Total consumption (l)** is the total fuel consumption of the vehicle at the time the message was sent.

- **Fuel level (%)** is the fuel level of the vehicle at the time the message was sent.

- **Total weight (t)** is the total weight of the vehicle at the time the message was sent.

**NOTE**

In the context menu of the messages list (right-click on a list entry), you can find the “Go to element” command, which you can use, for instance, to go from an order status message to the corresponding order in the tree view.

### 5.2.1.2 Various Message Types

#### Messages Sent from the Dispatch Office to the Vehicle

- **Free text message** 📨: Text message which was sent from the dispatch office to the driver of the vehicle. The reference of the message is displayed in the **Quick info** column. If you want to send such a message, please read Section Send Messages to a Vehicle, Page 23.

- **Position request** 🗺️: This message type is created if you request the position of a vehicle. If you want to send a position request, please read Section Request a Vehicle Position, Page 23.

#### Message Sent from the Vehicle to the Dispatch Office

- **Free text message** 📨: Messages which the driver formulates as free text and then sends to the dispatch office. The first part of the message is displayed in the **Quick info** column.
- **Position**: Contains information on the current position of the vehicle. Messages of the type *Position* can be received in two ways:
  - You can launch a position request manually (via the *Position request* button). Please refer to Section Request a Vehicle Position, Page 23.
  - The vehicle can be configured to automatically send position reports at pre-determined times.

- **Event**: Message which provides information on an event which took place during the transport (e.g. tank filled, tour accepted, congestion). Depending on the fleet configuration, the driver can transfer additional information together with the status message.

- **Confirmation**: Provides information whether a tour or order was received by the vehicle or was read by the driver.

- **Order-related messages (Activities)**: These can be messages regarding area entry, area exit, and delays. Moreover, the scan function can be used to enter or display messages on loading and unloading the vehicle (e.g. *Order accepted, Loading started, Order completed*).

**NOTE**

According to the configuration, various message types are displayed in Logistics. If you require further message types, please contact the FleetBoard Support.
5.2.2 Open the Detail View of a Message

Double-click a message to open the detail view for this message. In the detail view, you can find more detailed information on the message.

**NOTE** The detail view may vary in terms of the design and the information contained, according to the message type concerned.

5.2.3 Modify Data of Already Existing Orders

If you wish to change the delivery address of an order, for instance, which has already been transferred to a vehicle, proceed as follows:

1. Under *Info board > Vehicles*, double-click the order which you want to edit (or open it via a right-click on the context menu and click the *Open...* button).

   The order form will be opened.

2. Make your changes.

3. Subsequently, click the *Save* button.

   The modified data will be transferred to the DispoPilot installed in the vehicle. The corresponding changes will be marked and displayed on the DispoPilot.

5.2.4 Rearrange Tours or Orders Sent

If you wish to assign tours or orders to another vehicle subsequently, proceed as follows:

1. Select the corresponding tour or order on the *Vehicles* tab.

2. Click the *Rearrange* button.

   **NOTE** Alternative, you can also open the context menu via a right-click and click the *Rearrange...* option.

   The *Rearrange dispatch data* dialogue box will be opened.
3. Click *Rearrange* to delete the order for the vehicle.

You will receive a message that the order(s) has/have been rearranged.

4. Click *OK*.

The rearranged tour or order will now be completed for this vehicle. The driver will automatically receive a corresponding message. You can find these complete dispatch data sets via the *Search* component.

Copies will automatically be created for the rearranged orders. You can find them in the *Planning* component in the *Planning* list. FleetBoard will automatically assign new IDs to the orders.

The orders can then be assigned to a new trip and subsequently to a new vehicle.

### 5.2.5 Complete Orders and Tours Manually

**NOTE**

The following section explains how the *dispatch office* can manually mark orders and tours as completed. In the normal case, an order should be completed by the driver with the help of the defined procedure (transfer of status messages).
If already completed orders and tours have not been marked as completed by the driver, you can do this later on. To do so, proceed as follows:

1. In the Info board component, select the tour or the order you wish to complete on the Vehicles tab.

2. Click the Complete button.

**NOTE**

Alternative, you can also open the context menu via a right-click and click the Complete... option.

A new window will be opened.

3. Click Complete.

The selected order or all orders of the selected tour will then be marked as completed. The completed orders and tours will automatically be removed from the Vehicles tab.

Subsequently, you can only access them via the Search component.
5.3 Latest Infos

If you open the Logistics Management Client, the Latest infos component will first display the current position messages of all vehicles of your fleet issued since the application was started.

This list will be gradually filled by incoming and outgoing messages. As a maximum, the messages sent during the past 24 hours are displayed. You can find older messages on the Info board tab.

The table is set up in the same way as in the Info board and Search components. For more information, please refer to Section How to Read the Messages List, Page 71.

**NOTE**

As soon as an order is completed manually, the vehicle is sent a corresponding notification.

The manual completion can be configured in such a way that the vehicle sends a receipt confirmation as soon as this information is received.

For this purpose, please contact the FleetBoard Support.
# Chapter 6

## Search for Messages

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1</td>
<td>Structure of the Search Component</td>
<td>80</td>
</tr>
<tr>
<td>6.2</td>
<td>Search for Messages with Known ID</td>
<td>81</td>
</tr>
<tr>
<td>6.3</td>
<td>Search for Other Search Parameters</td>
<td>82</td>
</tr>
<tr>
<td>6.4</td>
<td>Evaluate the Search Results</td>
<td>83</td>
</tr>
</tbody>
</table>
6.1 Structure of the Search Component

The *Search* component allows you to search for tours, orders, and messages. Here, you can also find tours and orders which have already been completed. This way, you can reconstruct completed tours and orders.

The component is structured, as follows:

- **Search Section**: Here, you can start searching for vehicles, tours, orders, and packages.
- In the **Messages filter**, you can determine which messages will be displayed in the message list.
- In the **Messages list**, you can find the messages which belong to the tours and orders which have been found. A double-click on a message opens the detail view of the message (for further information on the message filter and the messages list, see Section Info Board, Page 69).
- The results of your search will now be displayed on the **Search results** tab.
6.2  Search for Messages with Known ID

If you know the ID of the tour or order, proceed as follows:

1. Enter the ID of the order or tour on the Search tab under ID.
2. Click the Search button.

The results of your search will now be displayed on the Search results tab.
6.3 Search for Other Search Parameters

1. On the Search parameters tab click on the Other option.

2. If you wish to search for tours or orders of a specific vehicle, select the vehicle in the vehicle list.

3. If you want to search for orders or tours of a specific type, select this type under Type.

4. Semantics: A semantic defines a specific feature of a data set or a specific data set type. By selecting a semantic, you can search for specific data set types, for instance only for text messages sent to the vehicle (semantics: fb\document\type\freetext).

5. Select an Operational status.
   - Complete: Only competed orders and tours will be found.
   - Updated: Data sets which were updated after being sent to the vehicle.
   - Received: Messages will be found which were sent by the vehicle and received by the central dispatch office.
   - Created: This option refers to data sets (tours/orders) which have been created, but not yet been sent. When searching for the operational status Created, no vehicle must have been selected in the vehicle tree. Click on the fleet
   - Sent: Only tours and corresponding orders will be found which were sent to the vehicle.

6. Click the Search button.

The results of your search will now be displayed on the Search results tab.
6.4 Evaluate the Search Results

After completing the search, the data sets which match your search request will be displayed on the *Search results* tab.

If you click on a specific tour or order, all corresponding messages will be displayed in the messages list on the right side of the window.

The columns of the table have the same meaning as on the *Info board* tab. Please refer to *Section How to Read the Messages List, Page 71*. A double-click on a message opens the detail view of the message with additional information.
Chapter 7
Appendix

7.1 Important Symbols ....................................................................................... 86
7.2 Modify Settings for the Log File ................................................................ 88
## 7.1 Important Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Fleet" /></td>
<td>Fleet</td>
</tr>
<tr>
<td><img src="image" alt="Vehicle Group" /></td>
<td>Vehicle Group</td>
</tr>
<tr>
<td><img src="image" alt="Vehicle" /></td>
<td>Vehicle</td>
</tr>
<tr>
<td><img src="image" alt="Trip" /></td>
<td>Trip</td>
</tr>
<tr>
<td><img src="image" alt="Loading order" /></td>
<td>Loading order</td>
</tr>
<tr>
<td><img src="image" alt="Unloading order" /></td>
<td>Unloading order</td>
</tr>
<tr>
<td><img src="image" alt="Order" /></td>
<td>Order</td>
</tr>
<tr>
<td><img src="image" alt="Message requests a receive confirmation." /></td>
<td>Message requests a receive confirmation.</td>
</tr>
<tr>
<td><img src="image" alt="Message was sent." /></td>
<td>Message was sent.</td>
</tr>
<tr>
<td><img src="image" alt="Message was received." /></td>
<td>Message was received.</td>
</tr>
<tr>
<td><img src="image" alt="Message was sent at least 30 minutes ago, but has not yet been received." /></td>
<td>Message was sent at least 30 minutes ago, but has not yet been received.</td>
</tr>
<tr>
<td><img src="image" alt="Order requests read confirmation." /></td>
<td>Order requests read confirmation.</td>
</tr>
<tr>
<td><img src="image" alt="Order has been read." /></td>
<td>Order has been read.</td>
</tr>
<tr>
<td>Symbol</td>
<td>Meaning</td>
</tr>
<tr>
<td>--------</td>
<td>---------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Symbol" /></td>
<td>Order was sent at least 30 minutes ago, but has not yet been read. If the order is read later on, the green eye appears.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Symbol" /></td>
<td>Outgoing message (sent to vehicle)</td>
</tr>
<tr>
<td><img src="image3.png" alt="Symbol" /></td>
<td>Incoming message (sent from vehicle)</td>
</tr>
<tr>
<td><img src="image4.png" alt="Symbol" /></td>
<td>Address message (only for Messaging)</td>
</tr>
<tr>
<td><img src="image5.png" alt="Symbol" /></td>
<td>Text message</td>
</tr>
<tr>
<td><img src="image6.png" alt="Symbol" /></td>
<td>Driver message (only for Messaging)</td>
</tr>
<tr>
<td><img src="image7.png" alt="Symbol" /></td>
<td>Message when using the navigation</td>
</tr>
</tbody>
</table>
7.2 Modify Settings for the Log File

For a subsequent analysis of possible failures, the computer and program information is saved in a log file. By default, this log file records data on the Info level.

You can find the log file under C:\Documents and Settings\Users.

In coordination with FleetBoard Support, you can change the level for the settings.

Configure the settings for the log file as follows:

1. To do this, go to Settings > System settings.

2. The Preferences window will be opened.

3. Under Log Level, select the entry specified by the support staff.

Subsequently, proceed as discussed with the support staff.

**NOTE** Make sure that after the successful analysis of the failure the original setting of the level is configured again.
Index

A
Address message 64
Administrate 27
Area entry 45, 73
Area exit 45, 73
Area monitoring 42, 43
Arrival monitoring 42

B
Buttons 18

C
Columns 20
Context 63, 71
Context menu 19
Create 27

D
Delay 44, 45
Detail view 74
Display messages 61
Drag & drop 20

E
Engine 63, 71
Events 58
Export 22

F
Fleet 14
Symbol 86
FleetBoard Logistics Management
Start 14
Free text message 63, 64, 72
Fuel level 63, 72

G
Geographical coordinates 29, 54, 59
GeoRef 29
Georeferencing 29, 59
Grid reference 29

H
Help 17

I
ID 30
Ignition 63, 71
Info board 55, 69

L
Latest infos 77
Latitude/longitude 59
Load 73
Log file 88
Log level 88
Logistics Management
Start 14

M
Mapping and georeferencing 30
Menu bar 16
Message
Detail view 65
Message filter 70, 80
Message types 63
Messages
- Display 70
- Position 63, 71
- Send 23
- Send date 63, 71
Messages filter 56, 61
Messages list 55, 62, 70, 80
Messaging 54
Monitoring 42, 43, 46
- Dialogue box 30
- Time zone 44

N
Navigation events 64
Navigation system 29, 58, 60

O
Odometer reading 63, 72
Online help 24
Order
- Assign to a tour 33
- Change the sequence 35
- Complete 75
- Create templates 50
- Delete 32
- Reset the allocation to a tour 36
- Symbol 86

P
Password 14
Planned time of arrival 44
Position 64, 73
Position request 23

R
Radius 45
Read confirmation 57
- Symbol 86
Receive confirmation 57
- Symbol 86
Reference area 42

S
Schedule 41
Search 80
Search section 80
Send address 58
Send message 56
Sequence of the orders of a tour 35
Settings 17
Shortcuts 88
Sorting 21
Speed 63, 72
Structure 34
Support 24
Symbols 86

T
Tabs 17
Templates 50
- Create 50
- Delete 52
Text message 63, 72
Time monitoring 43
Time of arrival 44
Time of creation 63, 71
Time zone
- Monitoring 44
Total consumption 63, 72
Total weight 63, 72
Tour
- Assign order 33
- Assignment to a vehicle 36
Change send time 41
Changing the sequence of the orders 35
Create 30
Delete 32
Schedule 41
Send 40
Send time 41
Symbol 86
Unschedule 42
Tours list 69

U
Unload 73
User name 14

V
Validity period 45
Vehicle
Assign a tour 36
Symbol 86
Vehicle group
Symbol 86
Vehicles list 69
Version information 24
View 16

W
Website 24
Width/length 29
Are there any further questions? FleetBoard Support is available from Monday to Saturday by phone under +49 69 95 30 73 74 or via e-mail under support@fleetboard.com
www.fleetboard.com/info/en